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ABSTRACT

This research focuses on developing a series of mobile learning applications for future
_beyond‘ classroom learning environments. The thesis describes the general use
pattern of the prototype and explores the key factors that could affect users attitudes
towards potential acceptance of the mobile learning applications. Finally, this thesis
explores the user acceptance of the mobile learning applications; and investigates the
mobility issue and the comparison of applying learning activities through mobile

learning and e-learning.
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Chapter 1: Introduction and Background

1.1 Introduction to the Study

Providing learners with effective learning experiences is always one of the key
concernsin the modern pedagogy. New educational technologies (e.g., online learning
or distance learning) have been proposed to meet this ever-achieving objective and
now mobile learning appears to be alternatively considered as a promising way of
supporting many educational activities, given the high mobile device penetration and
the high level of mobile phone usage within the potential target audience, i.e., the

younger generation (specifically, the Y generation).

Arguably, mobile learning is obviously seen as a new generation of learning
paradigm which follows the traditional lecture-based learning and the complimentary
e-learning pedagogy (Ryu and Parsons, 2008). Traditional lecture-based education
methods rely heavily on both printed materials (e.g., textbooks, teaching slides and so
forth) and face-to-face interaction in the classroom (e.g., lectures, tutorials and
laboratory work). It is widely said that this form of learning activities has significantly
restricted learners‘ mobility. Additionally, it can be said that this form of education has
a lack of learner engagement and motivation because it comes at the price of making
interaction between learners and lecturers harder and inefficient (Collis, 1996; Freeman
and Blayney, 2005; Harasim et al., 1995; Mason, 1998; Sorensen and Takle, 2002;
Traxler, 2005). Instead, to a greater extent, e-learning has overcome these limitations
of the traditional lecture-based learning activities, and highly applicable to other
learning activities such as life-long learning (Sharples, 2005). However, people have

now grown to expect more connectivity as a key factor of future learning activities,



thanks to the mobile penetration (Ryu and Parsons, 2008). Handheld devices have the
potential to effectively control —push” and —pull” information and deliver learning
content whenever and wherever the learners‘ needs arise. Many researchers or
educators have recognised that mobile technology for learning has the certain merits

(Brown and Metcalf, 2008).

As mobile technologies have been widely welcomed in relation to the nature of
modern learning activities, some researchers have gone as far as to say outlined
mobile learning might be superior when learning goes out of the classroom, e.g.,
children‘s field trips, language learning without having formal classes or children‘s
literacy programmes and so forth (Keegan, 2002; Scanlon and Issroff, 2005). Behind
this sense of understanding is a consideration of the amount of time for students to
spend outside the classroom and an attentive learning support for them during this
dubious time. Especially for university students, beyond classroom learning activities,
such as a review or preview of the course, play important parts in their learning
experiences. However, there are currently minimal studies in this research area, which

is the central research topic of this thesis.

This study focuses on developing a text-based mobile learning application (i.e.,
review or preview course content), benefitting university students by allowing them to
take their learning activities on their own mobile handset beyond the classroom
environment. Several experiments were designed to figure out the potential
acceptance of this mobile learning tool and the issues related to the _beyond classroom*
mobile learning experience. Further, we explored the main benefits of mobile learning,
comparing it with e-learning and thus to say if users can conceive mobility as one of

the key factors in their learning activities at the University campus.



1.2 Background to the Study

1.2.1  Definition of Mobile Learning

Mobile learning is not a new concept; its definition is still evolving along with the
advent of new technologies. Briefly, around a decade ago, Quinn (2000) described
mobile learning as learning activities which take place with the assistance of mobile
devices. In a similar vein, Traxler (2005) also defined mobile learning in a
techno-centric way; from his perspective, similar to Quinn‘s (2000), any education
where the sole technologies are handheld or palmtop devices can be considered as

mobile learning.

Contrary to the technology-oriented definition above, several researchers have
emphasised mobile learning as a pervasive learning experience which can rearrange
people‘s work, study and leisure time in meaningful ways (Turunen et al., 2003).
Likewise, Shaples (2005) claimed mobile learning has a very non-replaceable role that
can enhance communication and conversation between the education consumer and
producer. Polsani (2003) also argued the hardware-oriented definitions seem too
restrictive, viewing mobile learning as a new form of education —whose site of
production, circulation, and consumption is the network”, a.k.a., _ndworked learning*.
A tentative definition of mobile learning now widely accepted in this research
community, was proposed by Sharples et al. (2007), that —-mobile learning is the
processes of coming to know through conversations across multiple contexts amongst

people and personal interactive technologies.”

As one can see the brief discussion from above, it is not quite easy to define what

mobile learning is, but the following summaries will help readers to understand what



objectives mobile learning is currently serving (Winters, 2006):

Definitionl: Techno-centric view

Simply put, mobile learning is learning with mobile devices. One of the major
debates of this definition is whether or not to embrace laptop computers (with
or without e-learning through these computers). For example, Quinn (2000)
did not include them in his definition; in contrast, both Traxler (2005) and

Sharples et al. (2002) considered them.

Definition 2: Part of e-learning — Blended learning

The definitions related to this perspective often include traditional e-learning
systems, characterising the unique nature of mobile learning as blended
learning experiences with e-learning on mobile devices. For instance, Traxler
(2005) defined mobile learning as —somewhere on e-learning‘s spectrum of

portability”.

Definition 3: Mobility

In this perspective, the focus is on the mobility of the learner, which has not
been considered in any other computer-mediated learning activities. For
example, in lifelong learning, ongoing learning activities result from the
integration of formal and informal education, creating personal capability for
continuous lifelong development of quality of life, and so forth (Kruse, 2003).
Here, people rarely take their learning activities in a particular place such as a
classroom, or arrange some formal learning time such as a lecture, so

mobility-based learning may fulfill their needs to learn anytime anywhere they
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want. Sharples et al. (2002)°s definition applies to this perspective.

1.2.2  Why Mobile Learning?

The previous section presented diverse definitions of mobile learning encompassing
the techno-centric to user mobility standpoint. In this section, we explore why modern

pedagogy has been attracted to mobile learning in three main aspects.

Firstly, many say that the new Y generation, i.e., the -Mobile Generation”
pushed modern education towards the mobile trend. The innovation and popularisation
of mobile devices and technologies have permeated society to such an extent and the
perception of mobile phones is not just as telecommunication tools, but also key
digitalised information assistants in people‘s pockets (Wagner, 2005). For them,
mobile propensity remains attached to their mobile and nomadic lifestyles that shape
their modern hectic lifestyles, work, play and also learning (Lasica, 2007).Most
university students are especially _addicted* mobile users and have even been dubbed
-mobile addicts”. Oblinger (2004) considers the key traits of these university students
as being (1) digital literate, (11) always on, and (ii1) mobile and community oriented.
_Digital literate‘ refers to people who are very confident in their use of information
technologies which are critical for work, leisure and communication. People with
these traits are able to frequently use mobile devices to retrieve, access, store, produce,
present and exchange information, and to communicate and participate in
collaborative networks via mobile technologies (Rychen and Salganik, 2003; Gapski,
2007). The second trait _always on‘ refers to the fact that many students in the tertiary
education sector tend to be always communicating with friends, peers and instructors

constantly, through a range of digital devices and technologies such as mobile phones,



instant messaging (IM) or e-mail (Gapski, 2007). Hence, for them, the third trait
_mobile and community oriented* indicates that such students prefer to learn by doing,
as opposed to learning just by listening to an instructor or reading from materials.
Here, contributing to the learning community (e.g., with friends or peers) is important

in their learning activities.

Secondly, the development of mobile technologies and services would seem to
support the uptake of mobile learning in the near future. Recently, mobile phones have
become more and more sophisticated with wide implementation of incoming mobile
technologies and services such as Bluetooth, WAP (Wireless Application Protocol),
GPRS (General Packet Radio System) and UMTS (Universal Mobile
Telecommunications System). That is, the small devices have been no longer just a
talking machine, having turned them into personal assistant tools (Lu, 2007; Keegan,
2002; Sharples, 2000). These mobile technologies and services consequently enable
feasible mobile learning more than ever before. For example, in Thailand,
_Kittanasearee® (Brown, 2007) allowed students to access lessons anywhere by porting
all courses to their own mobile handset using their GPRS network, as shown in Figure
1.1. SMS (Short Message Service) and IVR (Interactive Voice Response) was also
applied in a joint endeavour between the University of Central Florida (UCF) and the
Ewing Marion Kauffman Foundation — called My Sports Pulse”, as shown in Figure

1.2 (Brown, 2008).



Figure 1.1Suchart Kittanasearee‘s m-learning course
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Figure 1.2 My Sports Pulse



Finally, mobile learning certainly offers the mobility benefit. Thanks to that, the
Y generation of learners is very much expecting learning to be done via mobile.
Unlike primary and secondary school students, university learners are not always in
the classroom, so the mobility issue is obviously more important. The university
learners require efficient learning supports to avail their learning activities anytime
and anywhere. Hence, mobile phones as —always on” personal assistant devices might
offer university learners a convenient approach to accessing learning materials and so
carry out their learning activities without time or location limitations. Also this can
facilitate instant and spontaneous communication and collaboration between learners

and educator, or learner and learner (Wagner, 2005).

By and large, the three reasons above briefly explain why modern pedagogy has
invited mobile learning in its pedagogical sphere. Though there would be many other
reasons to take account of it, one thing for sure is that the university learners and
mobile technologies are both ready to allow mobile learning in practice, and in
particular, the mobility benefits may attract the new generation‘s attention and fulfill

their needs.

1.2.3  Learning Activities outside the Classroom

Having said that the new Y generation would like to get into mobile learning, a key
question is how to apply mobile learning to their learning activity design outside the
classroom. Although classroom learning activities are still central to formal education,
outside classroom learning activities can also play an important role, particularly for

the tertiary education sectors (Solomon, 2002).

Table 1.1 depicts almost all the common learning activities at the university level.
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As it indicates, beyond classroom learning activities include those such as previews of
upcoming lectures, reviews of past lectures, assessment of courses, pop-quizzes,

report writing and related material reading.

Table 1.1 Current learning activities (In/ Beyond classroom learning)

Learning Activities In Classroom Learning/ Beyond
Classroom Learning Activities

Preview of the upcoming lectures Beyond
Lecture In
Review of the past lectures Beyond
Assessment Beyond
Pop quizzes Beyond
Report writing Beyond
Experiment In
Related material reading Beyond
Exam In

The main interests in this thesis are the three _beyond classroom learning
activities® from the table above: _Preview of upcoming lectures®, _Review of the past
lectures‘, and _Pop-quizzes‘. Preview of the upcoming lectures and review of past
lectures are necessary and important _beyond classroom learning® activities at

university.

Previews of upcoming lectures may help students to make connections between
the learning material from a previous class and the upcoming class, encouraging
students to pay attention during lectures (The Augustine Club, 1996). Reviews of past
lectures would also help students to digest and consolidate from previous lectures,
assisting what they have learnt to become knowledge retained in their memory for a
long time (Keelay, 1997). Quizzes, as the most effective form of review of past

lectures, are frequently employed at university. They offer an essential link between

9



the assessment of learning outcomes and the related resources given during lectures. A
lecturer‘s perspective involves figuring out how to improve the learning effect; and
from a learner‘s perspective, quizzes can encourage learner‘s motivation and
engagement, assisting them to identify their learning requirements (QIA Excellence
Gateway, 2008). Note that this quiz experience is currently implemented either in
lecture time or through e-learning systems. One can see the benefit of mobile learning if,
and only if, the quiz-based learning experience is well embedded in mobile learning.
Hence, this thesis aims to investigate empirically the effect of applying mobile
technologies to learning activities with quizzes (for review of past lectures and

preview of upcoming lectures).



1.3 Research Questions and Potential Contributions

The purpose of this study is to explore a series of text-based m-learning applications
called —Eearning beyond Classroom” to address the feasibility of this form of mobile
learning activities for university courses. Specifically, this thesis is based on the

following research questions:

Point 1: Would people accept these quiz-form mobile learning applications? If so,

how would they like to use it?

The acceptance of mobile learning includes (i) whether users can easily learn
to use mobile learning applications; (ii) the functionality of the mobile
learning applications can undertake the requirements of learning activities; and
(iii)) whether users can perceive them as convenient and efficient while

applying mobile learning.

Point 2: What benefits would be represented by this ,beyond classroom® mobile

learning activity, compared with e-learning?

E-learning is always considered the important barometer of mobile learning.
For this reason, comparison of mobile learning with e-learning will easily
locate the pros and cons of mobile learning. These benefits, if any, should be
the key points to attract learners to choose mobile learning tools to support

their learning activities.

Point 3: Whether users can also achieve learning outcomes through m-learning?

The mobility issue is the core part of mobile learning; however it has not been



thoroughly studied whether or not mobility can aroused the learning
enthusiasm of the learners, or enhance learners* learning activities. People may
expect to do their outside-classroom learning activities without time and

location limitations, but achieve the same learning outcomes.



1.4 Outline of the Thesis

Chapter Two further provides a review of the literature pertinent to the research topics
raised in this introduction. It focuses primarily on literature published in the mobile
learning and education technology research community. In particular, the review seeks
to show potential benefits of mobile learning compared with e-learning, in some areas.
Chapter Three describes an overview of the methodology employed in this thesis. Also,
it offers the proposed design of the _Learning beyond Classroom® application. In
Chapter Four, data analyses are made, and the next chapter discusses the key findings.
Finally, Chapter Six provides the recommendations for future research. The

implications are also highlighted and the limitations of this research are presented.






Chapter 2: Literature Review

In the previous chapter, we located two major issues to be explored in this thesis: (i)
the comparisons between m-learning and e-learning (hence to sketch out the key
reasons for learning in mobile way), (i1) the mobility issue and its ripple effects on the
design of mobile learning applications, i.e., the _beyond classroom® application. This

chapter further discusses these topics.

We first note that the comparison between m-learning and e-learning may
represent the reason why people have a strong inclination toward mobile learning
while they have been adopting e-learning. Despite many researchers having defined
mobile learning as part of e-learning (Traxler, 2005), there have also been identified
several differences between mobile learning and e-learning. Some of the differences
include the challenges or barriers of mobile learning; others include the benefits of
mobile learning which can attract people to do their learning activities in a mobile
way. It is widely believed that the mobility factor is the most attractive feature of
mobile learning (Wagner, 2005). In this sense, to be fair, we would like to discuss the
mobility issue of mobile learning and why it should be a key concern in a student‘s
learning experience. Modern learning activities (specifically, life-long learning or
tertiary learning) have been described using the term -nomadic”, which means
learners® life space is dramatically enlarged and they intend to take their learning on
the move (Reynard, 2008; Sharples et al., 2007). As a consequence, people are
expected to carry out their learning activities using mobile devices (Alexander, 2004).
This understanding, of course, leads us to focus on appropriate mobile learning

applications that purport these nomadic learning activities outside the classroom, and



how they ultimately make a difference in the learning experience.

With these two research questions in mind, the following sections further describe
each of the research questions, aligning them with relevant literature from the mobile

learning research community.

2.1 M-learning vs. E-learning

More often than not, e-learning is considered as a criterion of a successful mobile
learning project. For example, Chan and his colleagues (2001) compared mobile
learning used for outside and inside classrooms with a Web-based learning system,
called EduCities, finding that mobile learning could enable life-long learning with the
benefit of private and social enrichment (Chan et al., 2001). Contrasting e-learning
and m-learning, they identified that well designed and organised mobile learning
activities might take advantage of frequently changing instructional contexts or
environments to allow the learner to link content without time and location limitations

(Nash, 2007).

Indeed, much literature has pinpointed distinctive descriptive words for
e-learning and m-learning, for which one can easily see their differences. E-learning is
commonly referred as as —multimedia, interactive, hyperlinked, and media-rich”; on
the other hand, mobile learning is —spontaneous, intimate, situated, connected,
informal, lightweight, and personal” (Laouris and Eteokleous, 2005). Of course,
m-learning also can be interactive and hyperlinked as is e-learning, but its original

objective heavily rests on the Laouris and Eteokleous‘ definition.

To allow mobile learning to be spontaneous and situated, mobile learning is

16



using portable devices (e.g., mobile phones, laptop computers and or handheld
devices). In contrast, e-learning refers to learning wherein computers are primarily
used to enable learning between the learners, the teacher, and/or peers. It usually takes
advantage of adopting the Internet, or LAN (Local Area Network) and WAN (Wide
Area Network), for delivery of the information required to facilitate their learning, and
the interaction and facilitation of the entire learning session are only through computers
(Muir, 2006). M-learning, by contrast, mobile devices such as mobile phones or PDAs
(Personal Digital Assistants) are used for learning activities (Rosman, 2008), which

implies learning mobilities (Sharma and Kitchens, 2004).

Another significant difference between e-learning and m-learning can be found
in the media being employed. Quite often e-learning has the advantage of being
_madia-rich‘ since all sorts of media (e.g., video, audio, animation and so forth) can be
accessed easily with the help of various computer programs and a higher bandwidth of
the network. For instance, some videos and images that only run on specific software
can be easily accessed (Nash, 2007). By contrast, m-learning cannot use such various
forms of media due to the limited computing power and the diverse system
specifications. Having said that, m-learning requires data that must be run even without
the use of complicated software programs since mobile devices are not created to
handle data that ask large computation or memory storage (Sharma and Kitchens, 2004;

Nash, 2007).

In our age, Internet is the biggest information network in the world, providing
facilities such as e-mail, file transfer protocol (FTP), workgroups discussion or chat.
E-learning exploits World Wide Web (WWW) through the Internet, allowing a major

impact on _distance learning’. It is usually defined as a learning process during which
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the learner and faculty member are separated by space, time or both (Florida Distance
Learning Consortium, 2008). For instance, a number of online tutorial centers have
sprouted up all over the globe, where individuals can learn from tutors based in other
countries. Yet, the success of distance learning is not the exact case of mobile learning.
M-learning, on the other hand, has been aimed not only to gain information from a
community, but also to share information with a community. For instance, people who
are on the go can take pictures of their surroundings or the location they are currently at,
and share this information with a wider community. It means that mobile learning can
be more than just the distance learning that e-learning has purported. Hence, it is
important that the promptness of mobile learning should be noted. E-learning appears
to have a time delay when it comes to the information relayed from the instructor to the
student. In this light, the majority of e-learning methods that are implemented in
education systems involve the student’s responsibility to regularly check his/her e-mail
or to log on to specific websites to gain access to necessary information. This makes
e-learning somewhat _asynchronous‘ since information is not always received at the
same time as it is delivered especially when users can not access computer or internet.
In contrast, m-learning is _synchronous‘ since the student can gain information

whenever it is needed from the mobile device (Sharples, 2006).

Thanks to the limited computing power of mobile handsets, the content design
for mobile learning should also be different. The content of e-learning is often the
webpages. With the help of the Internet, there are large numbers of libraries and
repositories to be found with the related learning materials, even various media for
learning activities. In contrast, the content for mobile learning needs to consider the

device features and the _mobility* issue of mobile learning. The contents, therefore,



need to be ruggedised to fulfill the requirement of portable and interactive mobile
devices. The learning material also needs to be designed to be easily acceptable while

moving around without any extra cognitive workload (Nash, 2007).

Besides the differences described above, many researchers offered rather
different characteristics of m-learning and e-learning. Table 2.1 summarises the
comparisons — mostly from both Sharma and Kitchens (2004) and Nash (2007).
Although this table is very comprehensive, it still cannot cover all the differences
between m-learning and e-learning. However, it is the author‘s personal belief that
this is sufficient to see the key differences between e-learning and m-learning, and to

poise m-learning on whole learning activities.

Table 2.1 Comparison of e-learning and m-learning (Sharma and Kitchens, 2004;

Nash, 2007)

Enough memory Limited memory

Large screen Small screen

Wired bandwidth Wireless bandwidth such as
GPRS, G3, Bluetooth

Collaborative Networked

Media-rich Lightweight

Distance learning Situation learning

Simulated situation Realistic situation

More text- and graphics More voice, graphics and

based animation

Lecture in classroom or in Learning occurring in the

internet labs field or while mobile

Time-delayed (students Instant delivery of e-mail or

need to check e-mail or SMS
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websites)

Passive communication

Asynchronous
Scheduled
Audio-teleconference
common

e-mail-to-e-mail

Private  location (With
access to computers or
internet)

Travel time to reach to
internet site

Dedicated time for group
meetings

1-to-1 basis possible
Asynchronous and at times
delayed

Mass/standardized
instruction
Benchmark-based grading
Simulations & lab-based
experiments

Paper based

Ready access

Vast libraries and

repositories
Immersion multimedia

Skillful
interdisciplinary
connections

making

Trace history of ideas &
evolution of thought

Apply theory to primary
texts

Instant communication

Synchronous
Spontaneous

Audio-
video-teleconference
possible

24/7 instantaneous
No geographic boundaries

and

No travel time since
wireless connectivity
Flexible timings on 24/7
basis

1-to-1 basis possible
Both  asynchronous
synchronous

and

Customized instruction

Performance &
improvement-based grading
Real-life cases and on the
site experiments

Less paper, less printing,
lower cost

Portable, interactive

Limited media
Gather data

Integrate prior knowledge
Situated problem-solving

Able to integrate multiple
content source

Create -map”

Develop tangible —solution”
as outcome

In effect, mobile learning may be considered as the extension or evolution of

e-learning, which adds missing components of the solution (e.g. the mobile feature)
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(Sharples, 2005; Geogiew et al., 2004). Also, the comparisons discussed above
represent how to design and apply mobile learning in an appropriate way. According
to this, some differences such as limited memory or the small screen need to be paid
much attention to avoid poor performance of mobile learning. Other differences,
especially the mobility issue, may be the key attractions of mobile learning and this is
explored in the following section (Chris and David, 2002; Sharples, 2006; Uden,

2007).
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2.2 Mobility as a Key Concern

In Chapter 1, we claimed that mobility could be the central concern of any mobile
learning. Indeed, mobility refers to the ability to move freely from location to location,
and mobile learning is particularly created with the thought in mind that people do not
stay at one place all the time. Hence, the learning process in mobile learning would be
_nomadic‘ (e.g., learning can happen at workplace, at home or at places of leisure with
mobile learning (Vavoula and Sharples, 2002)), by which they do not need to stay in a
classroom or adhere to the conventional learning styles that classroom-based learning
activities imply. In addition, mobility indicates that learning can be mobile with respect
to time (Vavoula and Sharples, 2002). With mobile learning, people do not need to
schedule formal time for learning and are free to utilise any time (e.g., tea break during
they are working or travelling time while on the train or bus) they prefer to do some

learning activities.

In effect, the benefits of the mobility in mobile learning can be thus categorised
into three factors (Oblinger, 2006): _Choice’, _Control’ and _Embedded’. When it
comes to _doice’, the students can optimise their daily life with learning activities
through mobile learning. This would be especially useful for students who live away
from the educational institution. With mobile learning, they do not need to sacrifice
other time such as work to attend lectures; or waste time accessing formal education
institutions. An example of this factor would be Kittanasearee‘s m-learning course
mentioned in the previous section 1.2.2, which offered learners access to lessons
without actually going to the school (Brown, 2007). Freedom of learning choices in
mobile learning inevitably results in free _control® of their learning activities, where

self-regulation is significantly important (Oblinger, 2006; Dantec and Jowers, 2007,
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Naismith et al., 2004). Learners can control their learning activities without other
controls of instructors or someone else. They can choose their own learning directions,
discover their own learning resources, and formulate their own learning schedules.
Mobile learning encourages the motivation and engagement of learners, because they
feel they are in control of their learning activities. For example, MOBIlearn
(http://www.mobilearn.org) is a European-led research and development project using
mobile technologies to explore context-sensitive methods for mobile learning. One of
their missions is to develop mobile learning products and services to attract the
unemployed or homeless young generation without formal education. With the
assistance of mobile learning tools, learners can control their learning by themselves
to improve their literacy and mathematics (Ting, 2005). Following on from the factors
discussed above, mobile learning can be easily embedded into people‘s everyday life.
Even very smaller time intervals and any location can be well utilised to do some
learning activities. For instance, while waiting for the bus students may carry out
mobile learning activities or lining up for tickets (Oblinger, 2006). Several studies
examine this factor further. For example, the Swedish International Development
Agency offered African people information about HIV/ AIDS through mobile devices
without formal education, especially for the mobile population (Glanz, 2007). In
Australia, Adelaide Zoo explored a mobile learning trial to provide students with
information about pandas (Flexenews, 2008), in order to give an embedded learning

experience while they are roaming in the zoo.

By and large, it seems that the concept of mobility is thought to be closely linked
to the nature of mobile learning and modern education requirements (Naismith et al.,

2004).
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2.3 Mobile Learning implies Learning Activities outside the Classroom

Beyond classroom learning activities, unlike the lecture-based learning activities,
allows ones to proceed with learning activities at their own pace and place (Csete et
al., 2004). In particular, there is strong evidence that successful learning outside the
classroom gains a greater value compared to classroom learning (Learning Outside the

Classroom, 2006).

Indeed, despite classroom-based learning activities still being the core of any
academic education, work outside the classroom is said to give another in-depth
understanding of the curriculum and make an important contribution to students

physical, personal and social education (Ofsted, 2004).

In this sense, education practitioners and researchers have paid much attention to
applying mobile learning to design appropriate learning activity outside the classroom.
For instance, the Learning Skills Development Agency (LSDA) in the U.K found out
that a group of users (216 juvenile offenders) have been significantly motivated by
mobile learning, and actually preferred it to traditional in-classroom learning.
Interestingly, this group of users has significantly improved their social skills which
were not possible by any other educational measures for them (Livingstone et al.,

2006).

By comparison, Schwabe and his colleagues (Roschelle ef al., 2005; Schwabe and
Goth, 2005) viewed a mixed reality in which physical space is augmented with
contextual information on the mobile device, as the way forward in mobile learning. In
this study, they designed a prototype of mobile learning —Mobile Game”, exploring

the opportunities to support learning through an orientation game in a university
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setting. In the orientation rally, new students were separated into several groups. The
orientation rally was structured as a cooperative and competitive game. Each group
was assigned into different tasks which provided them with basic information about
university life, such as finding important places (e.g. the library, the cafeteria or the
laboratories); then performing relevant tasks (find a book, have drinks, etc.); and then
they needed to answer some simple questions displayed on the PDAs, such as —wWat is
the price of an apple pie?”. Unless the group members gave the correct answers to
these questions, they were not allowed to move to the next task. The tasks were
executed with the support of the -Mobile Game” application (e.g. providing with
related information), as shown in Figure 2.1. The study showed students engagement
and motivation from these outside classroom learning activities to be increased by

applying the location-aware mobile learning applications.
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Map: Gebdudeplan

Messagas from Sarver:
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Map: Gebdudeplan

Messages from Server:
Connected

_'_f‘?';l*‘lap: Gebdudey B - 4x13:28

Figure 2.1Screenshot of Mobile Game”

Ogata et al. (2006) also developed a _non-classroom* based language-learning
support system for overseas students in Japan —One Day Trip with PDA”. This
system was to assist overseas students of Tokushima University to learn Japanese
while involved in their daily life situation, using the PDAs. With the LOCH
(Language-learning Outside the Classroom with Handhelds) system, the instructors
assigned field activities to the students to go around the town; so they could learn
Japanese through their own individual experiences. The students interacted with
native Japanese speakers with the assistance of teachers through LOCH. The scenes of

26



the study were depicted in Figure 2.2. This study empirically confirmed that mobile

learning activities could be effectively embedded into learners® daily life

/ G

(1) At the beginning of the class, teachers are giving some tasks to  (2) The foreign student 1s asking the direction to a Japanese
overseas students. woman on the campus.

B2 20l

(3) The student 15 asking the direction for the destination at a
convenience store.

g y /
(5) During the trip, the teacher gets the location of each student (6) After the trip, the teachers reflect on their results and learn
and gives an mstruction. lessons.

Figure 2.2 Scene of -One Day Trip with PDA”
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Roschelle et al. (2005), and Thornton and Houser (2005), on the other hand,
linked informal, asynchronous and casual mobile learning activity with formal
classroom instructions. They created a series of web pages which could be viewed by
mobile phones for Japanese students to learn English idioms. Each web page presents
one idiom (e.g., _He has a big mouth.*). First, it explains the idiom‘s meaning in the
students® first-language which is Japanese in this case. Then it offers a computer
animation illustrating the literal meaning (e.g., a character with an unusually large
mouth), and presents an English script and live-action video. The video shows what
the idiomatic meaning in a real situation (e.g., a person who talks too much, giving
away secrets). At the end, a final quiz checks students‘ understanding. Figure 2.3
includes some screenshots of the mobile learning application. The experimental result
showed the mobile learning application significantly improved students‘ learning, and
outlined a successful way to intensify their existing learning activities (Roschelle,

2005; Thornton and Houser, 2005).
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Figure 2.3 Example pages from Thornton and Houser ‘s research
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2.4 Summary of Literature and Implications of Studies

This chapter discussed the comparison between e-learning and m-learning; explored
the mobility concept of mobile learning; and represented several previous studies
about mobile learning activities outside the classroom. Building upon this literature
review, this thesis focused on the three research questions which include the
acceptance of such mobile learning activities outside the classroom; what benefits
would be represented by this mobile learning activities compared with e-learning;
whether users can achieve similar learning outcomes with mobile learning, which has
been little investigated. To empirically find out answers to these questions, several
experiments are designed and the next chapter will discuss how the experiments are
designed and what methods are used for the experiments to empirically examine the

research questions in this thesis.
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Chapter 3: Methodology

This chapter describes the experimental settings and procedures of the empirical
studies carried out in this thesis. In particular, section 3.1 gives the purposes of a series
of experiments to examine the effectiveness of mobile learning applications. Section
3.2 describes the apparatus employed in the experiments. Section 3.3 describes the
method and procedure of the experiments. Finally, section 3.4 describes how the data

was collected and analysed.
3.1 The Experiments

The first experiment was to compare a review-based mobile learning application
against traditional e-learning systems. To empirically demonstrate this, participants
attempted -How to use Microsoft Word to produce documents” courses through both
e-learning (Condition A) and mobile learning (Condition B). As discussed in Chapter
2, review of the past lecture is one of the important learning activities which would
help students digest and consolidate the learning content they had studied from a
previous lecture, assisting what they had learnt to become the knowledge in their
memory for a long time (Keelay, 1997). In this study, we employed the online quizzes
from  the  Microsoft Office online support website (refer to
http://office.microsoft.com/en-us/help/FX100485331033.aspx). This website offers
multiple-choice questions about how to use Microsoft Office. As shown in Appendix
A, the learning application presents quizzes about how to use Microsoft Office.
Participants answered the questions and the subsequent page — Result & Comment
Page® (as also shown in Appendix A), provided the correct answers with related

comments and explanations. In this experiment, as a contrasting system, a mobile
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_Review* application was considered — the only difference being that it was
administered by mobile phones supplied or their own mobile phones. The details of
the mobile _Review* application can be found in Appendix B. Note that the mobile
learning application had exactly the same questions and results as those of the

Web-based e-learning system.

The second experiment was designed to compare the performance of mobile
learning _in‘ and _out‘ of the classroom. Most of the learning activities can be done in
the classroom, but mobile learning could also be employed out of the classroom. To
empirically demonstrate this, our participants attempted to review the —How to use
Microsoft Word to produce documents™ course in a classroom (Condition A) and out
of the classroom (Condition B). That is, after a lecture, in the case of Condition A, all
the participants were required to carry out a review of the course in the classroom
within an hour. In contrast, Condition B allowed the participants to go out of the
classroom (i.e., wherever they wanted to be) to do this within an hour. This
experimental setting was expected to show whether mobility that mobile learning
underlies would make a difference in learning experiences. In this experiment, we
employed the same Review* application as Experiment 1, but with different question

sets.

Finally, building upon Experiment 2, both the third and fourth experiments were
intended to measure the effectiveness of mobile learning applications in terms of the
time of learning activities — preview or review. While both preview and review
learning activities are necessary and important _out of the classroom* learning
activities in the university, we hypothesised that _preview* would be improved using

mobile learning, because this might significantly facilitate the preparation of future
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learning activities (The Augustine Club, 1996). If this hypothesis is confirmed by
these two experiments, one can easily foster the effectiveness of mobile learning
applications. To see the differences between _preview‘ and _review‘, Experiment 3
explored the learning activities with _review‘; and Experiment 4 with _preview‘. In
Experiment 3 (i.e., review-based learning), we compared the performance of a mobile
learning application just after a lecture (Trial 1) and just before the next lecture time
(Trial 2). In a similar vein, Experiment 4 (i.e., preview-based learning) compared the
learning performance just after a lecture (Trial 1) and just before the next lecture time
(Trial 2). Having set up these experiments in this way, one can see when mobile
learning would best serve each of learning activities and/or whether it would motivate

the learner ‘s attitude or preparation in their self-managed learning activities.
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3.2 Apparatus

The mobile learning applications used in this study were implemented with JAVA™,
The source codes for these programs are presented in Appendix C. The lecturer sent
them through Bluetooth™ or via e-mail to the participants, which enabled them to

download the applications to their own mobile device or the mobile phone given.

3.2.1 Hardware Issues

In all the experiments, several mobile phones were employed to run the mobile
learning applications. The applications were sent to the participants in two ways:

Bluetooth or E-mail. These will be discussed later.

The mobile phones employed in these experiments were Nokia™ 7610 as shown
in Figure 3.1. It is a Smartphone with 65 K colour and 176 x 208 pixels screen. At
their convenience, the participants were able to use their own mobile phone to run the

mobile application, in cases where they had Java-enabled phones.

Figure 3.1 Nokia 7610 (© JergenSundgot)
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An Asus™ F8sv notebook was employed to send the mobile learning application
by Bluetooth. Either way, the participants were sent an e-mail including the

application, as shown in Figure 3.2.

lobile learning applications Inbox | >

@ Pluto to me

The Java files can be download to the computer and then download to your own cell phone by USB Cellular Data cable

2 attachments — Download all attachments

0 Preview.java
8K Download

D Review.java
12K Download

& Reply =» Forward ® Reply by chat to realredrun

2P
ey

Figure 3.2 Screenshot of mobile applications sent by e-mail

We collected the performance of the participants after the experiment,
downloading their scores and answers for each question from either their own mobile

phones or the phone given to them.

3.2.2  E-learning system

As referred to in section 3.1, the e-learning system was considered as a control group
in Experiment 1 (see Appendix A for its details). E-learning is always deemed as an
important barometer of mobile learning. For this reason, a comparison between
m-learning and e-learning may show why people have a strong inclination toward
mobile learning while they have already adopted e-learning (or the other way around).
The students who enrolled in the course -How to use Microsoft Word to produce

documents” of —Business Information Processing” from the New Zealand Institution of
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Education were all used to reviewing the course with the online quizzes on this
website. As a result, through comparing the mobile learning application with this
e-learning system, researchers should easily be able to locate the pros and cons of
mobile learning. These benefits, if any, should be the key to attracting learners to

choose mobile learning tools to support their learning activities.

3.2.3  Design of the -Eearning beyond Classroom™ Application

In this thesis, two types of Eearning beyond Classroom” applications were considered,
i.e., Review’ and _Preview‘. As shown in Appendix B, the mobile _Review*
application begins with the _Welcome‘ Page, followed by several question pages.
Each question page has one question and its related result page. There are five

questions in the application.

Instead, the mobile _preview‘ application shown in Appendix B began with
several pages of notes such as important definitions or case studies about the
upcoming lectures. After the pages of notes, the mobile _preview* application follows
exactly the same structure as the mobile _review* application, i.e., the question pages

and result pages.

3.2.4  Questionnaires

The post-questionnaires studies were considered for all the experiments in this thesis.

The details of the questionnaires are described in Appendix D.

In Experiment 1, we focused on exploring whether users can easily learn how to
use mobile learning applications against the traditional e-learning application. Hence

the questionnaire considered five categories: ease to learn, simple usage, convenience,
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utility and attitude to use in the future. This type of questionnaire design is well
supported by many HClI-related studies (e.g., Szajina, 1996). In contrast, after the first
experiment, all of our participants were already familiar with how to use the mobile
learning application; we considered _Suitability® as replacement of _Simple usage* to
see whether the mobile learning application would be well suited to the students’

environment, in particular, beyond the classroom environment.
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3.3 Method

3.3.1  Participants

Participants were randomly recruited from the students who enrolled in the Business
Information Processing” at the New Zealand Institution of Education as well as several
students from Massey University. They had all taken the same courses about How to
use Microsoft Word to produce documents”. For each experiment, 40 participants were

recruited. Table 3.1 shows the number of participants in each experiment.

Table 3.1 The number of participants for each experiment

Experiment Number of
Participants

1 40

2 40

3 40

4 40

3.3.2  Experimental Design

The first experiment was to compare mobile learning with e-learning. The participants
used a computer connected to the Internet for the Web-based learning; and also used a
mobile phone for mobile learning. A within-subject design was hence applied. Note
that the same 40 participants were recruited for the following three experiments, i.e.,
Experiment 2, 3, and 4. To avoid the order effect, in the first experiment, the 40
participants were divided into two groups. The one group firstly took the e-learning
system then the mobile learning application; the second group did this in reverse. The

details of the first experiment can be found in Table 3.2.
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Table 3.2 Experimental design of the first experiment

Group Number of Experiment Design

Participants
1 20 E-learning—> Mobile learning

2 20 Mobile learning—> E-learning

In Experiment 2, half of the participants (Group 1) used the mobile learning
application in a classroom, and the other half (Group 2) out of the classroom. A
between-subject design was then applied in this experiment. The details were shown

in Table 3.3.

Table 3.3 Experimental design of the second experiment

Group Number of Experiment Design

Participants
1 20 In a classroom
2 20 Out of the classroom

In Experiment 3, Group 1 used the mobile learning application to review the
course just after a lecture was given, and the other half (Group 2) employed the
mobile learning application a week later, just before the next lecture. A
between-subject design was then applied in this experiment. The details were shown

in Table 3.4.
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Table 3.4 Experimental design of Experiment 3
Group Number of

Experiment Design
Participants

1 20 Just after the lecture
2 20 A week later, just before the next lecture

Likewise, in Experiment 4, half the participants (Group 1) used the mobile
learning application to preview the following lecture, just after a lecture was given,
and the other half (Group 2) did the same preview just before the next lecture a week
later. A between-subject design was applied in this experiment. The details were

shown in Table 3.5.
Table 3.5 Experimental design of Experiment 4

Group Number of Experiment Design

Participants
1 20 day 1 (the day having the previous class)
2 20 day 2 (the day having the lecture)

These treatments in Experiment 3 and 4 were considered to reveal what ways
would more motivate students to benefit from the learning effect with the mobile
application given, such as preparation for future learning activities. Table 3.6

summarises the details of all experiments.
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Table 3.6 Details of experiment design

Experiment Comparison Trials Target Experiment
Design
1 E-learning form vs. | Compare mobile Within -Subject
mobile learning form | learning with
e-learning
2 In classroom vs. Figure out if the Between -Subject
beyond classroom location factor affect

mobile learning

3 Review after the Find out if the time | Between -Subject
lecture vs. before the | factor affect mobile
next lecture learning

4 Preview after the Between -Subject

previous lecture vs.
before the lecture
time

3.3.3  Procedures

In Experiment 1, all the participants were first provided with the instructions
regarding both the mobile learning application and the Web-based learning system,
including the general information about the experiment and the purposes of the
research. In this experiment, participants were first separated into two groups of 20
participants. Group 1 firstly gathered in a computer lab to review the course with the
Web-based e-learning application. After this trial, they were required to complete a
post questionnaire. They were then asked to use the mobile learning application. The
participants could use either the mobile phone given, or their own phones to download
the application and run it. After this learning session, they also needed to fill in a post
questionnaire. Group 2 took the mobile learning trial first then e-learning with the

same experimental procedure.

In Experiment 2, the same 40 participants were divided into two, consisting of 20
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people each. The first group used the mobile learning application in a classroom;
Group 2 did the application out of the classroom wherever they wanted. This
experiment was administered in the lunch time so many of them used the mobile

learning application on a bench or in a café.

In Experiments 3 and 4, participants needed to do the review and preview by
mobile learning at different times. The details of the different times for the
experiments were explained above. In Experiment 3, one group of participants firstly
reviewed the course content on the same day as the lecture (Condition A) and the
other group reviewed the course content just before the next lecture, i.e., a week later
(Condition B). The mobile application was sent by either e-mail or Bluetooth on the
lecture days. The participants needed to finish the reviewing within an hour, and were
then asked to give back the questionnaires. A week later, Group 2, who were asked to
come to the classroom an hour earlier, needed to review through the mobile learning
application just before the lecture and gave back the questionnaires at the beginning of

the lecture.

In Experiment 4, a group of participants firstly previewed the course content of
the next lecture just after the lecture (Condition A) and the other half previewed the
content of the next lecture before the next lecture (Condition B). This is expected to
reveal which way would motivate their future learning activities the most. Like
Experiment 3, the application was sent by e-mail just after the lecture (Group 1). A
week later, Group 2 was asked to come to the classroom an hour earlier and

completed their preview just before the lecture.
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3.4 Data Collection Procedures and Statistical Analysis

Questionnaires were provided for data collection as quantitative measurements. After
each trial, participants needed to fill out the questionnaires. The questionnaires offered
five point scale evaluation questions. In Experiment 1, there should be an additional
final question that asks which solution they prefer after they finish the two

comparison tests. The details can be found in Appendix D.

For this study, SPSS 15.0 for Windows was employed to analyse the data collected
from each experiment. The data was analysed using Paired-samples T tests and
ANalysis Of VAriance (ANOVA). The hypotheses in these experiments were the mean
values would be higher than the neutral score (3 on the Likert-point scale) or containing

differences in different conditions.
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Chapter 4: Results

4.1 Experiment 1

Table 4.1 E-learning vs. m-learning

E-learning 3.80 0.46 0.53
M-learning 3.85 0.48 )
E-learning 3.53 0.51 070
M-learning 3.57 0.50 )
E-learning 3.23 0.66 534
M-learning 3.85 0.43 )
E-learning 3.25 0.54 7,08
M-learning 4.00 0.45 )
E-learning 3.10 0.50 _8.20
M-learning 3.93 0.35 )

-000
-000

-000

n.s.
p<0.01
p<0.01

p<0.01

Table 4.1 summarised the subjective ratings from Experiment 1, which included the

five categories: ease to learn, simple usage, convenience, utility and attitude to use. The

results of the experiment are presented for the rating categories respectively. These

data were applied to explore whether or not students using mobile learning would

perform better than with e-learning. Paired-samples T tests were carried out to

compare the mean ratings of each scale between the mobile learning and e-learning

trial.
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3.85

Rating

E-learning M-learning
M Ease to learn 3.8 3.85

Figure 4.1 Ease to learn

In detail, Figure 4.1 shows the ratings of —Ease to learn” across e-learning and
m-learning. The mean rating was 3.80 in e-learning, and m-learning was 3.85. As
expected, users could learn the mobile learning application to review the course as
easily as the Web-based learning tool did. A Paired-samples T test was used to test
whether or not the —Ease to learn” for m-learning and e-learning differed any. As
shown in Table 4.1, Paired-samples T test showed there was no significant difference

between m-learning and e-learning (t=-0.53, n.s.).
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3.53 3.57

E-learning M-learning
M Simple usage 3.53 3.57

Figure 4.2 Simple usage

Similar to Figure 4.1, Figure 4.2 shows both mobile learning and e-learning have
a similar rating around at 3.5, which means most participants thought the usage of the
mobile learning application was as simple as browsing a webpage. A Paired-samples T
test also confirmed that there was no significant difference between them (t= -0.70,

n.s.) in the -Simple usage” category.
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3.85

E-learning

M-learning

H Convenience

3.23

3.85

Figure 4.3 Convenience

In Figure 4.3, the higher rating was 3.85 in m-learning; and e-learning was 3.23.

Obviously, it seemed our participants thought that learning though mobile devices

would be more convenient than e-learning. A Paired-samples T test showed there was

a significant difference between m-learning and e-learning (t= -5.34, p<0.05).
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Figure 4.4 Utility

Figure 4.4 shows the rating of —Wtility” across e-learning and m-learning. The
rating of m-learning (mean = 4) was higher than e-learning (mean = 3.25), which
means the utility of the mobile learning application might be more attractive to our
participants. A Paired-samples T test was applied to prove the significant difference

between these two learning approaches (t= -7.08, p<.05).
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Figure 4.5 Attitude to use

Similar to the previous two figures, Figure 4.5 shows that our participants gave
the impression that they would like to use m-learning against e-learning. According to
this comparison, most of the participants preferred the mobile learning application to
support their learning activities in the future, which would be a clear measure in many
studies of the Technology Acceptance Model (Gao, 2005; Koufaris, 2002; Mathieson,
1991; Morris and Dillion, 1997). Through the Paired-samples T test, we compared the
mean values of —Attitude to use” between mobile learning and e-learning, revealing a

significant difference (t=-8.20, p<0.05).

On the whole, in both the —Ease to learn” and —Simple usage” scales, there were
no significant differences; however, our participants seemed to feel mobile learning
might be better than e-learning regarding convenience, utility and attitude-to-use.
Having said that, most participants were already familiar with the Web-based learning
tool; the fact that m-learning approaches achieved a similar level of preference to the

Web-based learning system indicates other benefits of the mobile learning application
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would be quite implicative.
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4.2 Experiment 2: Comparing Mobile Learning in the Classroom vs. out of the

Classroom

From the previous experiment, mobile learning showed certain benefits over e-learning,
especially in terms of attitude-to-use. In this experiment, following Experimentl, we
intended to explore whether or not the mobility issue of mobile learning underscores its

benefits.

Table 4.2 In the classroom vs. out of the classroom

In the Outside the
Classroom Classroom

Categories
Mean S.D. Mean S.D.

QI Ease to
Operation

3.95 39 385 37 691 411 n.s.

Q2 Suitability 3.10 S5 4.05 22 50.807 .000 p<0.01
Q3Convenience 3.35 .59 4.00 32 18778  .000 p<0.01
Q4Utility 3.95 39 385 49 507 481 n.s.

Q5Attitude to Use 3.35 59 4.5 37 26725 .000 p<0.01

Table 4.2 summarised the subjective ratings from Experiment 2, which referred
to the following five categories: ease of operation, suitability, convenience, utility and
attitude to use. Note that we replaced _Sinple to use” with —Suitability” in this
experiment, partly because the same participants from Experiment 1 were invited
again, and mostly because Experiment 2 was carried out to identify whether mobile
learning would be suitable —eutside the classroom” where many other learning
activities would take place. Hence, these data were applied to explore whether the
location factor (i.e., in or out of the classroom) would affect the performance of
mobile learning activities. The results were described by a one-way ANOVA analysis
for each category.
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Interestingly, there were no significant differences in terms of _utilty‘ and _ease
to use‘. That is, our participants saw the two different learning contexts, i.e., inside vs.

outside, would not determine the benefits of mobile learning.

4.5 4.05

In the classroom Outside the classroom
# Suitability 3.1 4.05

Figure 4.6 Suitability

Yet, the other three ratings were more or less indicative. Figure 4.6 shows the
—Suitability” issue of mobile learning in the two different contexts. The —suitability”
issue focused on exploring whether the mobile learning application would be well
suited to learning situations, in particular beyond the classroom environment. The
subjective rating of taking the mobile learning application out of the classroom was
quite high (mean = 4.05), which was obviously higher than in the classroom (mean =
3.1). A novelty effect might explain this difference. The one-way ANOVA revealed a

significant difference (F1,38= 50.807, p<0.01).
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Figure 4.7 Convenience

b

Figure 4.7 implies the benefit of mobility, which might lead —eonvenience to use’
of a mobile learning application does not have any geographical limitation to use. The
subjective rating was 3.35 for mobile learning in the classroom and outside the
classroom was 4.00, which was significantly different between in and out of the

classroom (F1,38=18.778, p<0.01).
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Figure 4.8 Attitude to use

Likewise, Figure 4.8 depicts our participants looking at the mobile learning
application to use it out of the classroom rather than in the classroom environment. A
one-way ANOVA test confirmed that there was a significant difference between in and

outside the classroom (F1,38=26.725, p<0.01).

On the whole, our participants seemed to feel mobile learning outside the
classroom might be better off than in the classroom in terms of suitability and
convenience perspectives. That is, without the restriction of location (i.e., classroom),
it can be safely said that users can achieve more benefits and convenience through

mobile learning activities.
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4.3 Experiment 3: Review with Mobile Learning Applications at Different Times

Building upon Experiment 2 exploring the mobility factor in mobile learning activities,
both Experiments 3 and 4 further focused on the time factor, whether this may affect
the performance of mobile learning activities out of the classroom. These two
experiments were analyzed in the same way as Experiment 2, and administered out of
the classroom. Note that Experiment 3 compared review-based learning with mobile
devices at different times; and Experiment 4, preview-based learning, which is

discussed in the next section.
Table 4.3 Review-based learning at different times

Day 1 (the day | Day 2 (the day
having the having the
lecture) next lecture)

Categories Sig.

%Lfrzifotr‘l’ 390 55 395 .22 141 10 | me
Rl 350 51 330 66 1.152 290 ns.
Q3 Convenience |EEE] .39 3.85 37 .691 411 n.s.
O 375 44 390 45 1132 294 ns.
Q3 Attitude to - Ry U - S 1) 097 757 | ns.

Use
Table 4.3 shows the subjective ratings from Experiment 3, which includes the
same five scales as Experiment 2. The results of the experiment are presented
separately for each category. These data were applied to explore whether the time
factor (i.e. the day of the lecture or the day of the next lecture which occurs a week
later) would affect the preference of the review-based learning with mobile devices
outside the classroom. The each subjective rating was statistically analyzed by a

one-way ANOVA test.
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According to the subjective ratings as shown in Table 4.3, in all five scales, there
were no significant differences between these two trials. This implies that our
participants seemed to feel the review-based learning activity with mobile devices

might not be affected by when the learning activity occurred.
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4.4 Experiment 4: Preview with Mobile Learning Applications at Different Times

To further confirm the findings from Experiment 3, Experiment 4 employed rather

different learning activities that would generally take place outside classroom —

Preview-based learning with mobile devices at different times.

Table 4.4 Preview-based learning at different times

Day 1 (the day | Day 2 (the day
having the having the
lecture) next lecture)

S dall 385 49 395 51 400 Sl |
Operation

Q2

St 40 32 385 a7 1.879 178  ns.
385 49 390 31 150 701 ns.
onvenience

Q4 Utility 3.80 .62 3.95 .39 .842 365 n.s.

QS5 Attitude 395 39 3.85 49 507 481 n.s.
to Use

Similar to the results of Experiment 3, Table 4.4 shows that overall five scales,
there were no significant differences between these two trials, which again confirmed

the results of Experiment 3.
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4.5 An Additional Analysis: Review vs. Preview with mobile learning applications

Note that Experiment 3 compared the review-based learning with mobile devices at

different times and Experiment 4 for preview-based learning. We further compared

these two experiments to figure out whether mobile learning activities outside the

classroom might play an important role in improving learners‘ engagement and

motivation.

Table 4.5 Review-based learning vs. preview-based learning

Categories

Q1 Ease to
Operation

Q2
Suitability
Q3

Convenience

YR,

Q5Attitude
to Use

Review 3.93 0.42
Preview 3.90 0.50
Review 3.40 0.59
Preview 3.93 0.35
Review 3.90 0.38
Preview 3.88 0.40
Review 3.83 0.45
Preview 3.88 0.52
Review 3.58 0.50
Preview 3.90 0.44

Learning Mean Std
Deviation t Sig. (2-tailed)
330 753 n.s.

-4.891 .000 p<0.01
.330 .743 n.s.
-.628 .534 n.s.

-3.911 000  p<0.01

Table 4.5 shows that the preview-based learning had significantly higher ratings

for —Suitability” and -Attitude to use”, implying the preview-based learning with

mobile devices might be better than review-based mobile learning. That is, mobile

learning might be good for motivating students to take part in the learning activities

outside the classroom.
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Chapter 5: Discussion

This chapter interprets the findings based on the three research questions described in
Chapter 2. Table 5.1 summarizes the research questions with answers. The details are

represented in the following sections.

Table 5.1 Summary table of research questions and answers

Research Questions Answers Related
Experiments

1 | Would people accept these quiz-form Confirmed. Experiment 1
mobile learning applications?
If so, how would they like to use it? | They would like to use | Experiment
it without time and 2,3and 4
location limitation.
2 | What benefits would be represented Convenience and Experiment 1
by this ,beyond classroom“mobile Utility.
learning activity, compared with
e-learning?
3 Whether users can also achieve Confirmed Experiment 3
learning outcomes through and 4
m-learning?

5.1 Experiment One

The first experiment compared the subjective ratings of the five categories of
—Fechnology Acceptance Model” (Gao, 2005; Koufaris, 2002; Mathieson, 1991;
Morris and Dillion, 1997) between e-learning and m-learning. The experimental
results confirmed people would accept the quiz-form mobile learning application (the
first question depicted in Table 5.1); also the mobile learning activities represented
certain benefits over e-learning, particularly for convenience, utility and attitude to

use in the future (Research Question 2 depicted in Table 5.1).
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Figure 5.1 Comparison between m-learning and e-learning

Figure 5.1 again shows the experimental outcomes of Experiment 1, conceiving

many possible explanations. One is that the acceptance of the quiz-form mobile

learning application may be confirmed. For the first research question, we tried to

figure out the acceptance of mobile learning applications according to the following

three hypotheses:

(@)

(i)

Users can easily learn to use mobile learning applications.
As shown in Figure 5.1, users can easily learn to use the mobile learning
application — indeed, as easily as a Web-based learning application, to

support learning activities.

The functionality of the mobile learning applications can achieve the
requirement of learning activities.
Figure 5.1 shows that our users thought the utility of mobile learning

applications would perform better than e-learning while fulfilling the
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requirement of learning activities.

(i11))  Users perceive mobile learning activities as convenient and efficient.
Through the comparison, one can see that the users applying the mobile
learning applications found them to be as simple as the Web-based

learning applications.
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5.2 Experiment Two

In the second experiment, we explored the mobility issue of m-learning activities

outside the classroom.

Rating

4.5

3.5

2.5

1.5

Ease to
Operation

Suitability

Convenien
ce

Utility

Attitude to
Use

B In the Classroom

3.95

3.1

3.35

3.95

3.35

B Qutside the Classroom

3.85

4.05

4

3.85

4.15

Figure 5.2 The result of Experiment 2

The figure above represents the results of Experiment 2. It clearly shows that

users preferred to take mobile learning activities outside the classroom, especially

considering suitability, convenience and attitude to use. The possible explanation is

that users may like to do mobile learning activities in a more _mobile* way. Thanks to

the mobility in mobile learning, they may like to carry out their own learning

activities without restricting themselves in the classroom, implying this could be a key

feature of mobile learning. This referred to the second part of Research Question 1;

and partly answered the third research question.
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5.3 Experiments Three and Four

Besides the mobility issue of mobile learning, the results of Experiment 3 and 4
suggesting that mobile learning could enhance learners‘ engagement and motivation,
appear to be the most significant finding in the thesis. It can be said that Figure 5.3
shows the preview-based mobile learning activities were performed better than the
review-based, especially in suitability and attitude to use. This also refers back to the

first and third research questions.

4.5

35

Rating
(98)

2.5

1.5

Ease to o . .. Attitude to
Operation Suitability | Convenience Utility Use
B Review-based 3.93 34 3.9 3.83 3.58

B Preview-based 3.9 3.93 3.88 3.88 3.9

Figure 5.3 Additional analysis to compare review vs. preview
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Chapter 6: Conclusion

6.1 Findings of the Thesis

During the last decade, the adjective -mobile” has become a commonplace descriptor
of any social forms. There is general agreement in the literature that the profound
impact of Information Technology (IT) and its rapid adoption by individuals, groups,
organizations and communities has given rise to the proliferation of -mobile societies”.
The field of instructional technology has been no exception, using hard technology (e.g.,
computer-assisted instruction or mobile learning). When we think of how new
technology can support learning, what typically comes to mind is the design of tools
and artifacts (e.g., curriculum, assessments, and teaching and learning samples) that the
members of a community might effectively use to help them learn. However, we further
claim that equally important is consideration of how and when new tools and artifacts
are introduced to, and assimilated into, the practice of members of a community. In this
regard, this thesis explored whether a text-based mobile learning application could be

useful to support users® learning activities, in particular outside the classroom.

Indeed, from this study, we cannot safely say mobile learning is better than
e-learning, or _mobility’ can significantly improve people‘s learning outcomes.
However, at the very least, mobile learning activities can be seen to play apart in
people‘s learning and especially suitable for learning activities out of the classroom.
The main conclusion, therefore, would be people might accept mobile learning

activities outside the classroom if well organized.

In addition, in practice, the results suggest the designer of such mobile learning

applications needs to ensure users can perceive _mobility‘. Arguably, though this
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needs further investigation, we may conclude that mobile learning would encourage
the embedding of learning in students during their daily lives out of the classroom —
and motivate them to learn in a more _proactive® way. Their active engagement and
motivation to learn are, of course, highly relevant to the user‘s perception of the
content, so that the mobile learning application can be implicative of the appropriate

learning subject.
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6.2 Implications of this Study

The results of this thesis imply that mobility is a key factor of influencing critical user
experiences with new mobile learning activities beyond the classroom. Compared
with traditional learning approaches, such as paper-based (or face-to-face
lecture-based) and e-learning, the key expectation underlying mobile learning can
offer learning mobility without locational and temporal limitations. Future
improvements of such mobile learning tools would have to offer users more freedom,

allowing them to self-arrange their own learning activities.

Current mobile learning developments usually seem to focus only on applying
more advanced or upcoming technologies or services, such as GPRS and other
sensing devices through mobile devices. However, considering the practical situations
of college education, most students may not be equipped with such advanced mobile
phones or they may not want to pay an extra subscription fee. Hence, crucial to the
success of mobile learning development, lies on affordable technologies or services,
rather than catering for fashion or advanced learning approaches. That is why this
thesis considers the text-based mobile learning application, as a more appropriate

learning approach satisfying some requirements of users.
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6.3 Limitations of the Study

Despite the optimistic conclusions described above, there are still many limitations that
need to be addressed in future research. Firstly, from the experimental perspective,
inevitably the number of participants and the learning course settings were two main
limitations. The sample size was somewhat small so the results may not provide
sufficient proof. Furthermore, the learning course, i.e., How to use a Microsoft Office
Word XP to produce documents”, seems too simple, so the learners were not
significantly experiencing the requirement of _beyond classroom learning‘. In future
study, we may explore other content more suitably affecting performance of mobile

learning activities outside the classroom.

Technical limitations seem to be also noted. One of the main characteristics of
Bluetooth is to cover only a relatively short range — typically up to 10 meters. As a
result, Bluetooth in our experimental studies was not an effective method of sending
applications to the mobile devices, which was why we considered sending the
application by e-mail, as an alternative. In addition, most Bluetooth adopted in mobile
phones will send the file sequentially, limiting the speed of transmission in our

experiment.
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6.4 Future Work

The future work would firstly focus on the limitations described above. At the same
time, we have been planning to develop some authoring tools for the text-based mobile
learning application. As such, these can help the education provider (e.g. lecturers)
easily edit the learning content. In addition, future research also explores how to use the
—Eearning beyond Classroom” application alongside traditional learning and
e-learning activities. With rational organization, learners may achieve ideal learning

outcomes though this blend of learning pedagogy.
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Appendix A: Screenshots of E-learning Tool

1. A new tab will appear on the Ribbon if: SaVE!
© a. You click the Picture command on the Insert tab.
C b You select a picture. ﬁ bygnaaﬁ

O & You right-click a picture and choose Picture Tools.

@ d. Either A or .

2. Where is the Quick Access Toolbar and when should you use it?

O a ltis in the upperleft comer of the screen, and you should use it far your
favarite commands.

O b It floats above your text, and you should use it when you need to make
formatting changes.

@ ¢ Itis on the Home tab, and you should use it when you need to quickly
launch ar start a new document.

3. You can create bulleted lists by using the tab and the qroup.
© a. Page Layout tab, Paragraph group.

@ h. Home tab, Paragraph group.
O ¢ Inserttab, Symbols group.

O d. Insert tab, Text group.

4. Which corner of the Word window has the zoom control?
O a Upper-right.

@ b, Upper-lef.
O . Lowerleft,

O d. Lower-right.

5. The Mini toolbar appears when:
@ a. You double-click the active tah on the Ribbon,

O b Yoo select text.
O ¢ You select text with the mouse and then point at it.

O d. Any of the above.

Check by Answers

# Product Support  ® Microsofk Update  » Office Developer Center  # OFfice for Mac
# Microsoft,com # TechiMet # Advertise with Us # Office Community

This is the first page of the e-learning approach chosen from the Microsoft Office
online support website. On this page, five learning questions are offered. Users can
tick their answer and click the -€heck My Answers” button to go to the next page.



Rate this quiz: W0 W0 W
Comment on this quiz

€« myvfax:

by email!

1. A new tab will appear on the Ribbon if:
Your answer: Incorrect.
d. Either & or .

b. ou select a picture.

In Word 2007, certain tabs appear only when you need them. Faor example,
let's say you'e inserted a picture. But now you want to do mare with it. Mayhe
you want to change how text wraps around it or you want to crop it.

When you select a picture, the additional Picture Tools appear, with the
Format tab showing groups of cormmands for warking with pictures.

When you click away fram the picture, the Picture Tools disappear.

On-demand tabs appear for ather activity areas, too, like tables, drawings,
diagrams, and charts.

2. Where is the Guick Access Toolbar and when should you use it?
Your answer: Incorrect.

c. It is on the Home tab, and you should use it when you need to quickly
launch or start a new document.

a. It iz in the upper-left comer of the screen, and you should use it for your
favarite commands.

The Quick Access Toolbar is in the upper-left comer of the screen, above the
Ribbon (but you can rmove it to below the Ribbon if you want — just right-click
it and use the commands on the shortcut mena). It contains the commands
that you use over and over, every day: Save, Undo, Redo or Repeat, and
Print. And you can add your favorite commands to it so that they are available
no matter which tab you are on.

The above screenshot shows the second page which is the result and comments
page.
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Appendix B: Screenshots of “Learning beyond

Classroom” Applications

Review

+5550000 - DefaultColorPhone
MIDlet Wiew Help

Launch
[ e = o |
| M=
' =l T
1 2 asc 3 oer J
4cu G ke G mno
7 pars 8w Qwxvz
= * 0 nt A

After the Review” application is installed, the application will appear as shown. The
Application named —Review” will show in the Menu page of cell phones. Users can
choose —Eaunch” to activate the application. Then a —Welcome Page” will be
displayed.

111



Fall =3 BB
Welcome Page

Welcome to use makile learning.

Exit Start

Information about lecture can be presented on this page. By pressing —Start” the
content of the Review should be displayed.

|T..||| = BB
Review Question

|Review Gestion 1 |

Ques=tion 1: A new tab will appear on the

Ribbon if:

®)au click the Picture command on the Insert
takb.

Cvou select & picture.

Cvau right-click a picture and chooze Picture
Tool=.

IEither & or C.

ezt

Use the direction buttons on the cell phone to change the choices and validate the

choice by pressing the middle of the direction button. "Next” should lead to the result of
the first question.

If the choice is correct, the result will show as below.



F il =3 ED
Result
Correct
Back et

If the Choice is wrong, the result and comment will be displayed as in the
following figure. This result screen will offer users the right answer and some
explanation and references.

Im =3 B
Re=zult

The correct answer is (hnYWord 2007, certain
Itabs appeat only when you nesd them. For
example, let's say you've inzetted a picture. But
frovey wou weant to da more with it Maybe you
weant to change hovy text wwraps around i or you
weant to crop tWhen you select a picture, the
additional Picture Tools appear, with the Format
Itak shovwwing groups of commands far warking
with pictures When you click away from the
picture, the Picture Toolz dizappear On-demand
taks appear for other activity areas, too, like
takles, drawings, diagrams, and charts.

|Back et

The Back” button on the Result pages can go back the related quiz page.

From Question 2, the Back” button on the Question page can go back to the
previews question page as shown in the following figure. The last question result page
will have an —Exit” button to quit the application.



|T‘ il = B
Review Question

|Review Guestion 2

Question 2: Where is the Quick Access

Toolbar and when should you use it ?

®t iz inthe upper-left corner of the screen,
and you should use it for your favorite
COmmands.

(Ot floats above your text, and you should use
it wwhen you need to make formatting
changes.

ik is an the Home tab, and you should use it
wehien you need to quickly launch or start a
newy document.

Back et

VI



Preview

[F ol = B
Select one to launch:

Launch

After installation, the icon of Rreview” will be displayed on the menu screen. As with
—Preview”, use Eaunch” to activate the application. Also, the “Welcome Page” should
be the first screen of this application.

(F il & B
Welcome Page

Wielcome to use mobile learning.

Exit Start

The —Start” button will lead to the notes pages as shown in the following
screenshot.

Vil



[F &3 BB
Caze

Upper case and lowwer case text iz familiar to you
but there iz alzo Sentence case (only the first
weard of sertence capitalized) and Title case
(first letter of all words capitalized, as in "Bullz
Soccer Club™).

Eack Mext

After several Note Pages, the application also offers several preview questions.

o B

Preview Question

Presiesy Ciuestion 1 |

Question 1: You want to use the Copy and
Paste commands to work with text.
Where do you find them on the Ribbon?
®nzert tab.

Z'Home tak.

2 Gwick Access Toolbar.

|Eack Mext

Use the direction buttons on the cell phone to change the choices and validate the
choice by pressing the middle of the direction button. ”Next” should lead to the Result

page.
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'E} B |F aunll

F il
|RESUH

53 B

Result

Correct

The correct anzwer iz b

Back

The zet of most-uzed commands extends across
the first laver, or tak, of the Rikbon, called the
Haome tab. These commands suppor typical
tasks, including copying and pasting, adding
slides, formatting text and paragraphs, working
with shapes, and finding and replacing text.

Mext | |Back

et

After several questions, the last page should contain some more points to study,
named —Future work” page.

F ol = ED
Future work

Step by step - Create a neww document and save
Iit.

Step by step - Retrieve your file, then cloze it
Step by step - marging, porratlandscape.

|Eack Exit

The —Exit” button will quit the application.






Appendix C: Source Codes of “Learning beyond Classroom”

Applications

Review

/*

* MyFirstMobileApp.java

%

* Created on 24 March 2007, 13:49
*/

import javax.microedition.midlet.*;
import javax.microedition.lcdui.*;
import javax.microedition.io.*;
import javax.wireless.messaging.*;

/**
*

* @author 02370891
* (@version
*/
public class Review extends MIDlet implements CommandListener {

private Form mainForm, Quiz1, Quiz2,Quiz3 ,Quiz4, Quiz5, Resultl, Result2, Result3,
Result4, Result5;

private Command exitCommand, backCommand1, backCommand2, backCommand3,
backCommand4, backCommand5, backCommand6,

nextCommand1, nextCommand2, nextCommand3, nextCommand4, nextCommand5,
nextCommand6, nextCommand7, nextCommandS8, nextCommand9, nextCommand10;
privateChoiceGroup q1, q2,93,94,95;

public Review (){

exitCommand= new Command("Exit", Command.EXIT, 0);
backCommand1= new Command("Back", Command.BACK, 0);
nextCommand1= new Command("Start", Command.CANCEL, 0);
backCommand2= new Command("Back", Command.BACK, 0);
nextCommand2= new Command("Next", Command.CANCEL, 0);
backCommand3= new Command("Back", Command.BACK, 0);
nextCommand3=new Command("Next", Command.CANCEL, 0);
backCommand4= new Command("Back", Command.BACK, 0);
nextCommand4= new Command("Next", Command.CANCEL, 0);
backCommand5= new Command("Back", Command.BACK, 0);
nextCommand5= new Command("Next", Command.CANCEL, 0);
backCommand6= new Command("Back", Command.BACK, 0);
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nextCommand6=new Command("Next", Command.CANCEL, 0);
/MbackCommand7= new Command("Back", Command.BACK, 0);
nextCommand7= new Command("Next", Command.CANCEL, 0);
/MbackCommand8= new Command("Back", Command.BACK, 0);
nextCommand8= new Command("Next", Command.CANCEL, 0);
/MbackCommand9= new Command("Back", Command.BACK, 0);
nextCommand9= new Command("Next", Command.CANCEL, 0);
nextCommand10= new Command("Next", Command.CANCEL, 0);

ql = new ChoiceGroup("Question 1: A new tab will appear on the Ribbon if:",
Choice.EXCLUSIVE);

ql.append("You click the Picture command on the Insert tab.", null);

ql.append("You select a picture.", null);

ql.append("You right-click a picture and choose Picture Tools.", null);
ql.append("Either A or C.", null);

g2 = new ChoiceGroup("Question 2: Where is the Quick Access Toolbar and when
should you use it?", Choice. EXCLUSIVE);
g2.append("It is in the upper-left corner of the screen, and you should use it for your
favorite commands.", null);
g2.append("It floats above your text, and you should use it when you need to make
formatting changes.", null);
g2.append("It is on the Home tab, and you should use it when you need to quickly
launch or start a new document.", null);

//q2.append("storing", null);

g3 = new ChoiceGroup("Question 3: You can create bulleted lists by using the
tab and the group.", Choice. EXCLUSIVE);

q3.append("Page Layout tab, Paragraph group.", null);

q3.append("Home tab, Paragraph group.", null);

g3.append("Insert tab, Symbols group.", null);

q3.append("Insert tab, Text group.", null);

g4 = new ChoiceGroup("Question 4: Which corner of the Word window has the zoom
control? ", Choice. EXCLUSIVE);

g4.append("Upper-right.", null);

q4.append("Upper-left.", null);

g4.append("Lower-left.", null);

q4.append("Lower-right.", null);

g5 = new ChoiceGroup("Question 5: The Mini toolbar appears when: ",
Choice.EXCLUSIVE);

g5.append("You double-click the active tab on the Ribbon.", null);

g5.append("You select text.", null);

g5.append("You select text with the mouse and then point at it.", null);
g5.append("Any of the above.", null);

mainForm= new Form("Welcome Page");
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mainForm.append("Welcome to use mobile learning.");
mainForm.addCommand(exitCommand);
mainForm.addCommand(nextCommand]1);
mainForm.setCommandListener(this);

Quiz1=new Form("Review Question");
Quizl.append("Review Question 1");

Quizl.append(ql);;
Quizl.addCommand(nextCommand?);
Quizl.setCommandListener(this);

Result]=new Form("Result");
Resultl.addCommand(backCommand1);
Resultl.addCommand(nextCommand3);
Resultl.setCommandListener(this);

Quiz2=new Form("Review Question");
Quiz2.append("Review Question 2");

Quiz2.append(q2);
Quiz2.addCommand(backCommand1);
Quiz2.addCommand(nextCommand4);
Quiz2.setCommandListener(this);

Result2= new Form("Result");
Result2.addCommand(backCommand?2);
Result2.addCommand(nextCommand5);
Result2.setCommandListener(this);

Quiz3= new Form("Review Question");
Quiz3.append("Review Question 3");

Quiz3.append(q3);
Quiz3.addCommand(backCommand?);
Quiz3.addCommand(nextCommando6);
Quiz3.setCommandListener(this);

Result3=new Form("Result");
Result3.addCommand(backCommand3);
Result3.addCommand(nextCommand?7);
Result3.setCommandListener(this);

Quiz4= new Form("Review Question");
Quiz4.append("Review Question 4");

Quiz4.append(g4);
Quiz4.addCommand(backCommand3);
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Quiz4.addCommand(nextCommand8);
Quiz4.setCommandListener(this);

Result4= new Form("Result");
Result4.addCommand(backCommand4);
Result4.addCommand(nextCommand9);
Result4.setCommandListener(this);

Quiz5=new Form("Review Question");

Quiz5.append("Review Question 5");

Quiz5.append(q5);
Quiz5.addCommand(backCommand4);
Quiz5.addCommand(nextCommand10);
Quiz5.setCommandListener(this);

Result5= new Form("Result");
Result5.addCommand(backCommand5);
Result5.addCommand(exitCommand);
Result5.setCommandListener(this);

j
public void startApp() {

Display.getDisplay(this).setCurrent(mainForm);

}

public void pauseApp() {
h

public void destroyApp(boolean unconditional) {

notifyDestroyed();
}

public void commandA ction(Command c, Displayable s){

if(c== exitCommand)

destroyA{pp(true);

else if (c}== backCommand1)

Display. {getDisplay(this).setCurrent(QuiZ1);
else if (c}== backCommand?2)
Display.{getDisplay(this).setCurrent(QuiZ2);
else if (c}; backCommand3)
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Display.getDisplay(this).setCurrent(Quiz3);

else if ( }== backCommand4)
Display. {getDisplay(this).setCurrent(Quiz4);
else if (c}== backCommand5)
Display. {getDisplay(this).setCurrent(QuiZS);
else if (c}== nextCommand]l)
Display. {getDisplay(this).setCurrent(Quiz1);
else if (ci nextCommand?2)

Display.getDisplay(this).setCurrent(Result1);
if (q1.getSelectedIndex() == 1)

{
Resultl.append("Correct");
b

else
{

Resultl.append("The correct answer is (b).In Word 2007, certain tabs
appear only when you need them. For example, let's say you've inserted a picture but
now you want to do more with it. Maybe you want to change how text wraps around it
or you want to crop it."+

"When you select a picture, the additional Picture Tools appear, with the Format tab
showing groups of commands for working with pictures."+

"When you click away from the picture, the Picture Tools disappear.” +

"On-demand tabs appear for other activity areas, too, like tables, drawings, diagrams,
and charts.");

h

}
else if (c== nextCommand3)

{
Display.getDisplay(this).setCurrent(Quiz2);

}
else if (c== nextCommand4)

{

Display.getDisplay(this).setCurrent(Result2);
if (q2.getSelectedIndex() == 0)

{
Result2.append("Correct");

}
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else
{

Result2.append("The correct answer is (a)."+ "The Quick Access
Toolbar is in the upper-left corner of the screen, above the Ribbon (but you can move it
to below the Ribbon if you want — just right-click it and use the commands on the
shortcut menu). It contains the commands that you use over and over, every day: Save,
Undo, Redo or Repeat, and Print. And you can add your favorite commands to it so that
they are available no matter which tab you are on."

);
h
}
else if (c== nextCommand5)
{
Display.getDisplay(this).setCurrent(Quiz3);
}
else if (c== nextCommand6)
{

Display.getDisplay(this).setCurrent(Result3);
if (q3.getSelectedIndex() == 1)

{
Result3.append("Correct");
}

else
{

Result3.append("The correct answer is (b)." + "Once you have a
document open and have typed your text, you'll no doubt want to format that text. Many
familiar formatting commands are in view on the Home tab: Bold, Italic, Font Size, and
so on and there are several more you'll find useful here."

+"In the Paragraph group, you have the ever-popular bulleted lists, numbered lists, and
multilevel lists. You've also got your indentation and alignment commands here."

);

h

}
else if (c== nextCommand7)

{
Display.getDisplay(this).setCurrent(Quiz4);

h
else if (c== nextCommandS)

{

Display.getDisplay(this).setCurrent(Result4);
if (q4.getSelectedIndex() == 3)

{
Result4.append("Correct");

}

else
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Result4.append("The correct answer is (d)." + "After you insert
something, you may need a closer look at its details. So you'll definitely want to know
where you zoom."

+ "Look in the lower-right corner. Drag the slider to the right to zoom in, and drag it to
the left to zoom out."

+"The Zoom command is available on the View tab, t0o."

);
}
h
else if (c== nextCommand9)
{
Display.getDisplay(this).setCurrent(Quiz5);
}
else if (c== nextCommand10)
{

Display.getDisplay(this).setCurrent(Result5);
if (g5.getSelectedIndex() == 2)

{
Result5.append("Correct");
}

else
{

Result5.append("The correct answer is (c)."+ "Some formatting
commands are so useful that you want to have them available whatever you're doing."

+ "For example, let's say you're working on the Page Layout tab, and you want to
quickly format some text. You could click the Home tab to see the formatting options,
but here's a faster way."

+ "Select your text and then point at the selection. The Mini toolbar appears in a faded
fashion. If you point at the Mini toolbar, it becomes solid, and you can click a
formatting option there."

+ "The Mini toolbar is great for formatting options, but what if you want other types of
commands to always be available? Use the Quick Access Toolbar."

)
}
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Preview

/*

* MyFirstMobileApp.java

*

* Created on 24 March 2007, 13:49
*/

import javax.microedition.midlet.*;
import javax.microedition.lcdui.*;
import javax.microedition.io.*;
import javax.wireless.messaging.*;

/**
%

* @author 02370891
* (@version
*/
public class Preview extends MIDlet implements CommandListener {

private Form mainForm, Quiz1, Quiz2, Resultl, Result2, Futurework;
private Form Notel, Note2;
private Command exitCommand, backCommand1, backCommand2, backCommand3,
backCommand4, backCommand5,
nextCommandl, nextCommand2, nextCommand3, nextCommand4, nextCommand5,
nextCommand6, nextCommand?7;
/Iprivate TextFieldtxtName, txpassword;
privateChoiceGroup ql, q2;

public Preview(){

exitCommand= new Command("Exit", Command.EXIT, 0);
backCommand1= new Command("Back", Command.BACK, 0);
nextCommand1= new Command("Start", Command.CANCEL, 0);
backCommand2= new Command("Back", Command.BACK, 0);
nextCommand2= new Command("Next", Command.CANCEL, 0);
backCommand3= new Command("Back", Command.BACK, 0);
nextCommand3= new Command("Next", Command.CANCEL, 0);
backCommand4= new Command("Back", Command.BACK, 0);
nextCommand4= new Command("Next", Command.CANCEL, 0);
backCommand5= new Command("Back", Command.BACK, 0);
nextCommand5= new Command("Next", Command.CANCEL, 0);
nextCommand6=new Command("Next", Command.CANCEL, 0);
nextCommand7= new Command("Next", Command.CANCEL, 0);

/txtName = new TextField("User Name", "", 20, TextField. ANY);
//txpassword = new TextField("Password", "", 20, TextField. PASSWORD);
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ql = new ChoiceGroup("Question 1: You want to use the Copy and Paste commands to
work with text. Where do you find them on the Ribbon?",Choice. EXCLUSIVE);
ql.append("Insert tab.", null);
ql.append("Home tab.", null);
ql.append("Quick Access Toolbar.", null);

//ql.append("I AM", null);

g2 = new ChoiceGroup("Question 2: You are adding a new slide that you'll need to
insert a  picture onto. Which of these layouts should you
choose?",Choice. EXCLUSIVE);
g2.append("Blank.", null);
g2.append("Title and Content.", null);
g2.append("Title Only.", null);

//q2.append("T AM", null);

mainForm= new Form("Welcome Page");
mainForm.append("Welcome to use the Beaming Preview.");
mainForm.addCommand(exitCommand);
mainForm.addCommand(nextCommandl);
mainForm.setCommandListener(this);

Notel = new Form("Case");
Notel.append("Upper case and lower case text is familiar to you but there is also
Sentence case (only the first word of sentence capitalized) and Title case (first letter of
all words capitalized, as in —Bulls Soccer Club)."
);
Notel.addCommand(backCommandl);
Notel.addCommand(nextCommand2);
Notel.setCommandListener(this);

Note2 = new Form("Cut, copy and paste from clipboard ");
Note2.append("Moving or copying pieces of text from one place to another in your
document is called cut, copy and paste.");

Note2.addCommand(backCommand2);
Note2.addCommand(nextCommand3);
Note2.setCommandListener(this);

Quizl=new Form("Preview Question");
Quizl.append("Preview Question 1");

Quizl.append(ql);
Quizl.addCommand(backCommand3);
Quizl.addCommand(nextCommand4);
Quizl.setCommandListener(this);

Result]=new Form("Result");
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Resultl.addCommand(backCommand4);
Resultl.addCommand(nextCommand5);
Resultl.setCommandListener(this);

Quiz2=new Form("Preview Question");
Quiz2.append("Preview Question 2");

Quiz2.append(q2);
Quiz2.addCommand(backCommand4);
Quiz2.addCommand(nextCommando6);
Quiz2.setCommandListener(this);

Result2= new Form("Result");
Result2.addCommand(backCommand5);
Result2.addCommand(nextCommand?7);
Result2.setCommandListener(this);

Futurework=new Form ("Future work");
Futurework.append("Step by step - Create a new document and save it. "+"\n"+ "Step
by step - Retrieve your file, then close it. "+"\n"
+"Step by step — margins, portrait/landscape."
);
Futurework.addCommand(exitCommand);
Futurework.addCommand(backCommand4);
Futurework.setCommandListener(this);
}
public void startApp() {
Display.getDisplay(this).setCurrent(mainForm);
h

public void pauseApp() {
}

public void destroyApp(boolean unconditional) {
notifyDestroyed();

}

public void commandAction(Command c, Displayable s){
if(c== exitCommand)

{
destroyApp(true);

}

else if (c== backCommand1)

{

Display.getDisplay(this).setCurrent(mainForm);

}

else if (c== backCommand?2)

{
Display.getDisplay(this).setCurrent(Notel);
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}
else if (c== backCommand3)

Display. ;({getDisplay(this).setCurrent(Note2);
else if (c}== backCommand4)
Display. ;({getDisplay(this).setCurrent(Quiz 1);
else if (c}== backCommand5)
Display. ;({getDisplay(this).setCurrent(QuizZ);
else if (c}== nextCommandl)
Display. ;{getDisplay(this).setCurrent(Note 1);
else if (c}== nextCommand?2)
Display. :({getDisplay(this).setCurrent(Note2);
else if (c}== nextCommand3)
Display. ;{getDisplay(this).setCurrent(Quiz 1);
else if (c}== nextCommand4)
{

Display.getDisplay(this).setCurrent(Resultl);

if (q1.getSelectedIndex() == 1)

{
Resultl.append("Correct");
}

else
{

Resultl.append("The correct answer is b"+"\n"+ "The set of most-used commands
extends across the first layer, or tab, of the Ribbon, called the Home tab. These
commands support typical tasks, including copying and pasting, adding slides,
formatting text and paragraphs, working with shapes, and finding and replacing text.");

//Resultl.append(new Integer(ql.getSelectedIndex()).toString());

}

H
else if (c== nextCommand5)

{
Display.getDisplay(this).setCurrent(Quiz2);

H
else if (c== nextCommand6)

{

Display.getDisplay(this).setCurrent(Result2)
if (q2.getSelectedIndex() == 1)
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{
Result2.append("Correct");

}
{

else

Result2.append("The correct answer is b"+"\n"+ "If you know you'll want to insert a
picture or other type of graphic, such as a table or chart, on the slide, choose a 'content'
type of layout. These layouts contain one or more placeholders (the large boxes with a
dotted border that content goes into) that support a range of content types, either text or
a table, diagram, chart, picture, clip art, or media file. These content placeholders are
recognizable when you're choosing a layout, from the layout gallery, because they
contain a group of icons that represent all the content types. Layouts that contain
content placeholders include Title and Content, Two Content, and Content with Caption,
among others.");
//Result2.append(new Integer(q2.getSelectedIndex()).toString());

b

}
else if (c== nextCommand7)

{
Display.get Display(this).set Current (Futurework);
b

b

}
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Appendix D: Questionnaires
Experiment 1: Questionnaires (E-learning vs. Mobile Learning)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)
1. The application is easy to learn to use.
1 2 3 4 5
2. It is simple to use the tool to facilitate the learning.
1 2 3 4 5
3. It makes the beyond classroom learning more convenient.
1 2 3 4 5
4. The utility of this tool can fulfil the need of learning activities.

1 2 3 4 5

5. I would like to use this way to do the beyond classroom learning in the future.

1 2 3 4 5

Which way do you prefer to do in the future, e-learning approach or mobile learning

way?

[IE-learningl IMobile learningl INo difference
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Experiment 2: Questionnaires (In classroom vs. Beyond classroom)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)

1. Mobile learning can be easily operated under the situation (In classroom/ Beyond
classroom).

1 2 3 4 5
2. Mobile learning would be suitable to use under the situation.
1 2 3 4 5
3. It makes the learning activities more convenient.
1 2 3 4 5
4. The functions of the mobile learning tool can fulfil your requirement for learning.
1 2 3 4 5
5. I would like to use this way to do the learning activities in the future.

1 2 3 4 5
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Experiment 3&4: Questionnaires (Different Time)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)
1. Mobile learning can be easily operated at this time.
1 2 3 4 5
2. Mobile learning would be suitable to operate at this time.
1 2 3 4 5
3. It makes the review/preview more convenient.

1 2 3 4 5

4. The utility of this mobile learning tool can support the preview/review at this time.

1 2 3 4 5
5. I would like to do the review or preview at this time in the future.

1 2 3 4 5
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